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Volume 1: Tutorial 
Welcome 

Welcome to the SCIA·ESA PT Tutorial.  SCIA·ESA PT is a calculation program under Windows 
NT4/2000/XP with a large range of application: from checking simple frames to the advanced design of 
complex projects in steel, concrete, wood… 

The program includes the calculation of 2D/3D frames, including the profile check and the connection 
check for steel constructions.  The entire calculation and design process is integrated in one program: 
geometry input, input of the computational model (loads, supports…), linear and non-linear calculation, 
output of the results, elements check and optimisation to the different codes as well as generation of the 
calculation note… 

SCIA·ESA PT is available in three different versions: 

Licensed version The licensed version of SCIA·ESA PT is protected with a ‘dongle’, 
which is installed onto the parallel or USB port of your computer, 
either with a software licence, which is installed onto your network. 

SCIA·ESA PT has a modular structure.  The user chooses from the 
available modules to compose a calculation program, which 
perfectly matches his or her needs.  

In the general product overview of SCIA·ESA PT you will find an 
overview or the different available modules. 

Demo version If no protection was provided or if the program doesn’t find any 
protection, it will be started in demo version.  The properties of this 
demo version are: 

All projects can be entered; 

The calculation is restricted to projects containing 25 elements, 3 
plates/shells and two load cases; 

The output contains the watermark “Unlicensed software”; 

The projects that were saved in the demo version cannot be opened 
in the licensed version. 

Student version The student version contains all modules and is not restricted as 
elements or load cases are regarded.  It is also protected by a 
‘dongle’ or through the software. 

The output contains the watermark “Student version”.  Projects that 
were saved in the student version cannot be opened in the licensed 
versions.  
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Example 
 

The example of this Tutorial can be designed with the three versions.  The program must be installed 
onto a local computer or a network.  The installation procedure is described in chapter 2.  Before you 
proceed, you must be able working with your operating system: for instance working with dialogues, 
menu bars, toolbars, status bars, handling the mouse, etc.  

This Tutorial describes the main functions of SCIA·ESA PT for the input and calculation of a 3D steel 
frame.   

The figure below shows the hall that we will calculate in the first volume. 

 

 

Figure 1: Model of the construction. 

 

 

 8



SCIA.ESA PT 

Installation 
System requirements 

For the installation of SCIA·ESA PT, your system needs the following system requirements: 
 
Hardware requirements 

processor speed 730Mhz (recommended: > 1 GHz) 

RAM 256 MB (recommended: > 512 Mb) 

Graphic card 32 MB, OpenGL support 

Free disk space for program 250 MB 

Free disk space for projects and 
temporary files  

100 MB (the required space can amount up to several 
GB for very large projects)  

 

Software requirements 

MS Windows NT 4.0 MS Windows NT 4.0 with Service Pack 6 or higher, 

Internet Explorer 4.0 with Service Pack 2 or higher, 

MDAC 2.5 (version 2.50.4403.12, completed with 
file ODBCJT32.DLL with version number 4.0.4403.2 

MS Windows 2000 / XP This system contains all required components. 

 

Other requirements 

For the installation of SCIA·ESA PT you need administrator rights. 

For working with SCIA·ESA PT you need ordinary user rights. 

 

The general set-up program of the CD-ROM will automatically start when you insert the CD-ROM in 
the CD-ROM player.  You will obtain a menu listing all available software on the CD-ROM.  Follow 
the instructions on the screen to install SCIA·ESA PT. 
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Getting started 
Starting a project 

Before we can start a project, we first have to start the program.  Once the program has started, we can 
open an existing project or start a new one. 

 

Starting the program 

1. Double-click on the SCIA·ESA PT icon in the Windows Desktop. 

Or: 

2. If the icon is not installed, click [Start] and choose Programs > SCIA ESA PT .<version 
nr.> > SCIA·ESA PT. 

If the program doesn’t find any protection, you will obtain a dialogue listing the restrictions of the demo 
version.  A second dialogue will inform you why no protection was found.  Click [OK] in both 
windows.  The start screen of SCIA·ESA PT appears. 

 

For this Tutorial we will start a new project. 

 

Starting a new project  

1. If the dialogue Open appears, click [Cancel]. 

2. Click New  the icon in the toolbar.  

Now, the dialogue Project data is opened, in which general data about the project can be entered. 

 

Figure 2: Project data 

3. In the Data group, enter your preferred data.  These data can be mentioned on the output. 
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4. Choose Project level: Default and Model: One. 

5. Click on the rectangular button  below National Code to set up a default code for the 
project.  This code will determine the available materials, combinations and code checks.  For the 
Tutorial project, we choose EC. The Codes in project dialogue appears. 

a) Choose [Add]. 

The dialogue Available national codes appears. 

b) Select the European flag and click [OK]. 

You will return to the Codes in project dialogue and EC will be added. 

c) Select the flag named EC. 

d) Select the option Active code and click [Close]. 

You will return to the dialogue Project data and EC will be the active code. 

6. Select Frame XYZ in the Construction field. 
The type of construction (2D Frame, 3D Frame, 2D Plate, 3D Shell...) restricts the possible input 
during the calculation. 

7. In the Material group, select Steel. 

Below the item Steel, a new item Material will appear. 

8. Choose S235. 

9. Now, all information required to start the project has been entered.  Confirm by clicking [OK]. 

 

Note: 

 

Settings in the Project data menu: 
 
On the tab Basic data you can set a project level.  If you choose default, the program will only show the 
most frequently used basic functions.  If you choose advanced, all basic functions will be shown.  On 
the functionality tab, you choose the options that you need, filtering in this way the non-selected 
functionalities out of the menus, thus lightening the program. On the Combinations tab, we will set the 
default values for the partial safety factors.  For this “Tutorial volume 1”, the default settings will be 
used.  
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Project management 
Save, save as, close and open 

Before entering the construction, we first will discuss how to save a project, how to open an existing 
project and how to close a project.  When executing the project of this Tutorial, you can save the project 
every now and then.  In this way, you can leave the program any time and continue with the project at a 
later time from that point on. 

 

Saving a project 

1. Click   in the toolbar.  

If the project has not been saved yet, the dialogue Save as will open.  Click on the arrow in the list 
box Save in to select the disk where you want to save the project.  Select the folder where you want 
the project and click [Open]. Select sub-folders.  Enter the file name below File name and click 
[Save] to save the (empty) project. 

If you now click the  icon again, the project will automatically be saved with the same name.  If 
you choose File > Save as in the main menu, you can enter a new/other disk, folder and name for 
the project file. 

 

Closing a project  

1. To close this project, choose File > Close in the main menu. 

A dialogue box will appear, asking you if you want to save this project.  Depending on your 
answer, the project will be saved and the active dialogue will be closed. 

 

Opening a project 

1. Click  to open an existing project.  

A list of projects will appear on the screen.  Select the desired project and click [OK] (or double-
click the project to open it). 
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Screen structure 
Introducing the user interface 

The user interface is the part of the program, which is visible on the screen and which ensures the 
communication between the user and the program. Often, it is called a “graphic interface”. 

We will now introduce the different components to you one by one. 

Set-up 

A screen consists of the following components: 

Title bar The upper part of the application window, containing the basic 
information regarding the application. 

Status bar Shows information related to a certain program action 

Menu bar Contains the menu that can be used to control and operate the 
program. 

Menu tree window Contain a tree-like menu that is used to open the individual 
program functions. 

Graphic window Is a kind of application window, showing the drawing of the 
designed object.  The window shows the designed object, the 
calculated results and accepts mouse commands. 

Document window Is a kind of application window, showing the information about the 
designed object in tabular form, text comments and drawings. 

Print preview window Shows all kind of information in tabular form and drawings.  It can 
be used to edit object properties. 

Command line Can be used to type commands to control the program and also 
shows brief instructions regarding the required actions to be taken 
during individually running processes. 

Toolbar Enables fast access to the most general functions 

In addition to these default Windows application parts of a user interface, SCIA.ESA PT also uses a 
series of unique, especially developed control elements.  These will be described in separate chapters. 

 

Properties table 
The properties table is a unique control of SCIA.ESA PT that is used in the program dialogue screen as 
well as in the Properties window.  The control looks like a table.  The first column contains the name of 
each individual element.  The second column shows their values. 
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Figure 3: Properties table 

Generally, the values can be adapted in the “numerical cells” of the properties table. There are different 
ways to change the value.  Furthermore, the individual component of the table are linked either (i) to 
another part of the program either (ii) to a graphic screen.  

Database Manager 
The “Program database” manages the different libraries of the program. For instance, there is a material 
library, a section library, a catalogue blocs, etc.  The “Database manager“ contains tools to modify the 
entities of the program database.  

 

 

List of defined entities in the 
specific database  

The list shows all entities related to the database of the manager, 
which have been defined in the current project so far. 

Properties table  This table shows a brief summary of parameters for the database 
entity that has just been selected in the list of already defined 
entities (see above). 

Graphic window  This window shows a drawing of the database entity, whose 
parameters are listed in the properties table 

Control buttons  The button give access to functions, which are accessible from 
within the specific manager 

Filter  The filter ensures a legible representation of the data in the 
Manager 

 

Toolbar 
Toolbars are small “window look-a-likes” containing a number of buttons or icons.  The buttons can be 
used to open different functions.  The toolbars can be left floating on the screen or ‘docked’ at the side 
of the screen.  

We will introduce the different buttons in the next chapters. 
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Geometry input 
Input of the geometry 

When you start a new project, you must enter the geometry of the construction.  You can also draw the 
construction directly or use templates with parametric blocs.  

Profiles 
When entering one or more 1D structure elements, a profile type is immediately assigned to each 
member.  By default, the active profile type is represented.  You can open the profile library to activate 
another profile type.  When upon adding a structure part no profile type has been defined yet, the profile 
catalogue will be automatically opened. 

 

Adding a profile 

1. Click the Sections  icon in the toolbar. 
The first time you do this, the profile library will be scanned.  The Sections manager will be 
opened.  If no profiles have been assigned to the project yet, the New section dialogue will be 
automatically opened. 
 

 

Figure 4: The New section dialogue 

2. Click Profile library in the group Available groups to select a profile from the library.  The 
available elements will be shown. 

3. Click  in the group Available elements of this group  

The available I-profiles are shown. 

4. Select in the list in the middle the type HEA and in the right-hand list 200.  Click  to add this 
profile to the list of Elements in project. 

5. For this Tutorial, you add the following profiles: HEA260, IPE360, IPE400 and L60/6. The list 
Elements in project shows the already selected profiles.  
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6. Click [Close] to quit this dialogue. 

You will return to the Sections manager. 

7. Click [Close] to close this dialogue. 

You will return to your project. 

 

 

Geometry 
 

The Construction service  

1. When starting a new project, the ‘Construction’ service is opened.  If you want to change the 
construction at a later time, you must double-click Construction in the main menu. 

  

Figure 5:The main menu and the service Construction 

 

The easiest way to enter our structure is using the available blocs from the catalogue.  For this Tutorial, 
we could use the rRaser from 3D frame. For didactic reasons, we will however not use this predefined 
bloc, but build the construction using the simplest structure elements.  
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Entering a column  

1. To enter a new column, you use the option Column in the service Construction. 

 

Figure 6: The definition menu for a column 

2. Select HEA260 in the library.  Set the length of the element to 8 m. 

3. Confirm with the [OK] button. 

4. Position the element in the origin.  To this end, you enter the coordinates (0,0,0) in the 
command line and confirm with the <enter> button. (See figure)  

 

Figure 7: The command line 

5. Position the element in position (8,0,0) as well. 

6. End your input with the <Esc> key.  

7. The two entered columns are selected: they are highlighted in red.  Cancel the selection by 
clicking the <Esc > key once more. 

Notes: 

* The properties of the selected elements are shown in the properties window and can be modified. 
* If the project does not contain any section at the time when you order the definition of a structure 
element, the program will automatically open the dialogue box New section. 
* Any input can be ended either (i) using the ESC key, either (ii) with the right mouse button. 
* Click Zoom all  in the toolbar to see the entire construction. 
 

 

 

Drawing a member  

 17



SCIA.ESA PT 

Another method that can be used to add a construction part is the option Draw member.  With this 
option, you can draw members by defining the first and the end node.  When defining the nodes, we can 
either (i) enter the coordinates in the command line, either (ii) work graphically.  The setting of the pick 
mode for the mouse cursor here is highly important.  At the bottom right you can set this mode using 
the button [Pick mode].  We choose Centres and Starting points. 

 

Figure 8: The menu Cursor pick setting  

 

1. Activate the function Draw member in the service Construction. 

2. Set the properties. (IPE400)  
   

 

Figure 9: The Member menu 

3. Draw the horizontal member connecting the centres of the columns.  

4. End the drawing of IPE400 either (i) with the right mouse button either (ii) with the <Esc> key. 

5. Activate the function Draw member in the service Construction. 

6. This time, choose IPE360. 

7. Draw the member connecting the column heads.   

8. End the function Draw member either with the right mouse button either with the <Esc> key. 
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9. The last entered elements are selected by default.  Use the Esc key to cancel the selection. 

 

Figure 10: Already completed input 

We already have defined one truss.  The entire construction consists of three identical trusses. (See 
figure 1). Our next mission is to copy the already entered part twice.  The members connecting the three 
frames will be generated during the same procedure.  Therefore, we first have to activate the right 
profile type before we can start copying. 

 

Modifying the active profile 

1. Click  in the toolbar.  

The Sections manager appears. 

2. Select HEA200 and click [Close]. 

 

Now, we can copy the construction. 

 

Making multiple copies  

1. Select the construction using the button Select all . In this way, all members and all nodes are 
selected. (A selection is highlighted in red) 

2. In the selected nodes the trusses are mutually connected with active section (HEA200).  Deselect 
all nodes except the one located at the head of both columns. (See figure 11). Hold the <CTRL> 
key down and click with the left mouse button on the nodes concerned.  You can also invert the 
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mouse selection mode (button ) using the switch (button  ) and then click on the nodes to 
be deselected. 

A selected member is represented in red; a selected node is surrounded by a red box. 
 

 

Figure 11: Image of the selection 

3. Click the Multiple copies  button. 

The dialogue Multiple copies is opened. 

 

Figure 12: The Multiple copies dialogue 

4. Enter the data of the figure in and click [OK]. 

Three copies will be generated.  The distance between the trusses is 7 m in Y direction of the User 
Coordinate System.  The different trusses are connected by the selected nodes. 

 

Note: 

For absolute coordinates enter x,y,z, for relative coordinates you use @x,y,z 
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Drawing bracings 

 

1. In the service Construction, choose the option Draw member. 

2. Set the parameters according to the menu below: 
type:  horizontal bracing 
section: L60x8 
 

  

3. Draw the diagonals in the roof  
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Checking the construction 
Once our model defined, we can check the construction for correctly connected members by means of 
the tool Construction check. 
Apart from the correct connection of the construction elements, other errors are detected as well, such 
as free nodes, double nodes, double members, members with zero length... 

 

Checking a construction 

1. Click the option Construction Check in the Construction service. 

2. Carry out the check. 

3. The check menu indicates possible errors in the construction.  

 

Figure 13: The dialogue of the construction data check 

4. Click Continue to design the connections in the 6 nodes. 

5. All entities will be corrected as indicated in the menu.  

 

Below, you will find an image of the construction, in which all members are correctly connected.  The 
structure is represented by means of node and member names. 
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Activating a label for node names  

You activate the labels of the node names using the  button located at the bottom left.  

 

Activating a label for member names 

You activate the labels of the member names using the  button located at the bottom left. 

 

Relative and absolute nodes  

The nodes are relatively connected to the respective members.  A relatively connected node is 
represented as shown in the figure below.  
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Figure 14: Connected node 

By selecting the node, you can consult the properties in the table. We see that Node 6 is relatively 
connected on member B2.  It is located at half the member length.  This implies that an elongation of 
member B2 will lead to a displacement of node K6.   

 

Instead of working with relative nodes, we could have broken member B2 apart into two members, for 
which member B2 ends in node K6 and the new member begins in node K6.   

You proceed as follows. 

1. Click the “Break intersection” button ( button ) and select intersecting members.  

2. Confirm with <ESC> to connect the members with absolute nodes.   
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Hinges 
The members B3, B7 and B11 (IPE400 members) must be connected to the columns using a hinged 
connection, since the project is a 3D frame. The members transmit their forces through common nodes. 
The connection is rigid.  Using hinges, we can liberate the moments at the member ends.  

 

Adding hinges 

1. Double-click in the service Construction. 
The dialogue Hinges on member appears. 

 

Figure 15: Hinges on member 

2. Copy the data of the figure and click [OK]. 

3. The hinges will be added when you point the beams with the left mouse button. 

4. Click with the right mouse button in the graphic part to end the input.  

5. The entered hinges are still selected.  Press Esc to cancel the selection. 

  
Figure 16: Position of the hinges 
 

Note 
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>Hinges are defined with regard to the local axis of the member elements  
>The common properties of the selected elements can be modified through the properties table 

 

The bracings must be hinged in both ends for the bending moments.  Instead of defining first a hinge 
type and then selecting the members, we can work the other way round as well.  

As long as the service “Construction ” is active, the bottom of your screen will feature a number of 
predefined supports and hinges, which we now will use.  (Similar options are available for other 
services.  For instance, for the Load Cases service, you will find predefined loads). 

 

1. Start from the situation, where nothing is selected.  Select a bracing with the mouse cursor. 

2. Use a filter selection to select all bracings.  (See “Creating a filter selection”). 

3. Use the option “Hinge both ends” (button ) to have hinged members in both ends. 

 

Creating a filter selection 

We will use a selection filter to select all members with a particular identical property. 

1. Select a bracing with the mouse cursor.  

2. Activate the “section” field in the properties table. The profile type L60x8 is assigned to all 
bracings, and therefore is a unique property.  

3. Click the Filter elements per property button . 

All bracings of the roof will be selected.  If other members are selected as well, something is wrong 
with the profile assignment. 

 

 

 

Supports 
In this project, all column bases are perfectly restraint. 

We also could have used a filter to select all nodes with a Z coordinate equal to zero.  This time, we will 
illustrate the option Selecting using a window.  The procedure is as follows.   

 

 

 

Adding supports 

1. Click  in the toolbar to obtain a horizontal view. 

2. Select the content of a window (see below: making a window selection). 
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3. Double-click the  item in the Construction service  

4. Define a permanent restraint, as shown in the image below. 
 

  
Figure 17: Supports in nodes – Perfect restraint 

5. Return to the 3D view using the option . 

6. Press the <Esc> key to cancel the selection.  

 

Creating a window selection  

1. Position the mouse cursor at the desired position in the graphic part.  

2. Keep the mouse button down and slide the mouse from the left to the right. (Thus selecting only 
nodes and not the columns.  See note below) 
 

 

3. Release the mouse button. 

All entities intersecting the rectangle and those who are completely within the rectangle are 
selected. 

 

Notes: 
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* If the rectangle is drawn from the left to the right, only those entities located completely within the 
rectangle will be selected.  If the rectangle is drawn from the right to the left, not only the entities 
located completely within the rectangle, but also those intersecting the rectangle will be selected. 
* A number of predefined supports are defined.  For this example, we could have used the predefined 

“perfect restraint” (button ) at the bottom of the screen. 

 

Below, you will see an image of the model with hinges and supports. 

 
Figure 18: Model with hinges and supports 
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Modifying the graphic representation of the 
construction  
Modifying the image 

You have several possibilities to modify the graphic representation of the construction. Hereafter, we 
will discuss the main options: 

• Manually modify the viewpoint onto the construction  

• Setting a view direction 

• The magnifying glass 

• Modifying the image parameters through the “Image parameters” menu  

 

Modifying the viewpoint onto the construction 

Setting the viewpoint using the wheels.  At the bottom right of the graphic screen, three wheels are 
located, two horizontal and one vertical.  These wheels enable you to zoom or rotate the construction. 

 
1. To zoom or rotate the construction, click on the wheel (the cursor will change from an arrow shape 

into a hand), keep de mouse button down and move the wheel. 

Or 

Setting the viewpoint by means of a key-and-mouse combination. 

1. Simultaneously keep the CTRL + right mouse button down and move the mouse to rotate the 
construction. 

2. Simultaneously keep the Shift + right mouse button down and move the mouse to move the 
construction. 

3. Simultaneously keep the CTR+Shift + right mouse button down and move the mouse to zoom in or 
out on the construction. 

 

Note 

If you rotate the structure, while a node selection being active, you rotate the structure around the 
selected node. 

 

Setting a view direction with regard to the global coordinate system  

1. Click the button View in X direction  to obtain a view in X direction. 

2. Click the button View in Y direction  to obtain a view in Y direction. 

3. Click the button View in Z direction  to obtain a view in Z direction. 

The magnifying glass 
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Use  to enlarge 

Use  to reduce 

Use  to zoom in a window 

Use  to get a view of the entire structure 

Use  to zoom a selection 

 

Modifying the image parameters using the “Image parameters” menu  

 

1. In the graphic screen, click the right mouse button. The following shortcut menu appears. 
 

  
 
Note: 
If an element was selected previously, you can define a setting, which exclusively applies to the 
selected element. (An adapted shortcut menu will appear). 

2. Choose the option Set image parameters. The Image parameter setting dialogue appears.  The 
menu contains different tabs.  You can set the image parameters for all entities or only for the 
selected entities 
. 

Image parameters – Entities  

With the Entities tab, you can control the way in which the different entities are represented. 

In the Construction group, you should pay attention to the following items: 

Style and colour: you can represent the colour per layer, per material, per section or per CAD type 

Section: with this option, you put the symbol of the section onto each member.  

Member LCS: with this option, you activate the local axes of the members 
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Image parameters – Labels and Description  

With the Labels and Description tab, you can represent the labels on the different entities. 
In the Members group, you should pay attention to the following items: 

Label:  activate or deactivate a label 

Name: represent the name of the sections in the label.   

Section type: represent the type of section in the label  

Length: represent the length of the member in the label 

 

 

 

 31



SCIA.ESA PT 

Image parameters – Shortcuts  

In the toolbar at the bottom left, you will find a number of frequently used options. The most important 
are. 

Show/hide surfaces  to see the surfaces of the sections. 

Render geometry  to obtain a rendered view of the members. 

Show/hide node labels  to see the name of the nodes  

Show/hide member labels  to see the name of the members  

Show/hide supports  to represent supports and hinges 

Show/hide load  to make the load case visible 

Show/hide load labels  to show the value of the load  

Set load case for representation  to change the active load case  
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Calculation data input 
Load cases and load groups 

Each load (e.g. nodal load, line load…) is assigned to a load case.  A load case can contain different 
types of loads.   

To each load case, properties are assigned, which are determinant for the combination generation.  For 
instance, the action type of a load case can be permanent or variable. 

Each variable load case is associated with a load group.  The group contains information about the load 
category (wind, snow) and its appearance (default, exclusive).  For an exclusive group, the different 
loads assigned to the group, cannot feature together in a normative combination.  For default 
combinations, the combination generator allows the simultaneous occurrence of the loads of the same 
group. 

The way, in which you define load cases, is decisive for the load combinations created by the generator.  
We recommend that you thoroughly read the chapter regarding loads and combinations in the reference 
manual.  

For our example, we will define two load cases.  
- The first load case includes the permanent loads.  We will define the self-weight of all present 
members.  The weight of the floor must be added to the beams of the first floor.  The weight of the roof 
slabs must be added to the beams of the roof.  
- The second load case contains a simplified schematisation of wind, coming from the left-hand side. 

 

 

Defining a permanent load case   

Double-click in the Main service. 

Each load is classified in a load case. The program “knows” that the project does not contain any load 
cases yet and therefore will immediately open the load case manager. 

By default, load case LC1 is created.  This load is of the Self-weight type; the action type is set to 
permanent. 

Change the value of the Load type property from Self-weight into Default and describe this load case 
as “Static load”. 

 

Figure 19: Load cases – Action type: Permanent – Load type: Default 
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Defining a variable exclusive load case   

1. To create a second load case, click  or . 

LC2 is created and its properties are shown. 

2. Change the Action type into Variable and enter “Wind1” in the description field. 
 

 

Figure 20: A variable load case 

 

Load groups determine the generated combinations  

Each load is entered into a group.  These groups will influence the combinations that are generated 
as well as the code-dependent factors that will be applied.  The following logic is adopted.  

Variable load cases, which are not related to each other, are associated with different variable 
groups.  For each group, you set the category of the load (see EC1). The combination factors from 
the Eurocode are generated on the basis of the present load groups.  As soon as two load cases, 
belonging to different groups, occur in a generated combination, the decrease factors for transient 
loads will be applied.  

If the load is divisible, you enter the different part as individual load cases.  As long as no variable 
load, belonging to another group, figures in the load combination, no decrease factors must be 
applied.  The different load cases of a divisible load therefore are associated with one single 
variable group.  

Load cases of the same type, which may not act together, are brought together in one single group, 
which is made exclusive.  For instance, “wind x” and “wind y” are associated with one single 
exclusive group “wind”.   

 

Setting the properties of a load group  

By default, the permanent loads are put into load group (LG1).  

Click  to set the properties of the variable group of load group LC2. 
 

 

Figure 21: Properties of a load group 

Set the property Relation to Exclusive and EC1 load type to Wind 

Click [Close] to close the load case manager. 

 34



SCIA.ESA PT 

 

Loads 
 

Our example includes two load cases.  

• The first load case is of the permanent action type and includes all permanent loads.  
- The self-weight of the members of the model 
- The weight of the floor must be put onto the beams of the first floor  
- The weight of the roof slabs must be put onto the beams of the roof 

The second load case contains a simplified schematisation of wind, coming from the left-hand side.  

The two load cases are already defined.  They only need to be filled in. 

 

Changing the active load case  

Activate load case "LC1": 

1. Activate LC1, by pointing the mouse cursor onto it in the list box. 
 

 

Figure 22: Active load case 

 

Defining the self-weight through a distributed load 

 

1. We start from a situation, in which nothing is selected.  Use the  icon to cancel any previous 
selection.  

2.  Double-click . The line load on member dialogue appears on the screen. 
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Figure 23: Line load on member 

3. In the Type field, choose Self-weight 
Set the Gravity coefficient to –1. 

4. Confirm with [OK]. 

3. Select all members using the  icon. 

4. Click the right mouse button to confirm your input.  

5. Press the <Esc> key to cancel the selection.  

 

Entering a series of concentrated loads on members 

Apart from the self-weight, we will also add a number of concentrated loads to load case 1 for the 
modelling of the roof slabs and the floor. 

1. We start from a situation, in which nothing is selected.  Use the  icon to cancel any previous 
selection. 

2. In the service Load, choose the function Concentrated load on member by clicking the 
 button. 

3. The two beams of the first and the last frame are loaded with 5 concentrated loads of 10 kN.  
The first concentrated load of the series is located at 1 meter from the member end.  The 
clearance between the concentrated loads amounts up to 1.5m.  You obtain this configuration if 
you enter the parameters as shown in the figure below.  
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Figure 24: Concentrated load on member 

4. Select the beams of the 3 frames.  

5. Confirm your input with the right mouse button. 

6. Cancel the selection by pressing the <Esc>Key. 
 

 

Adapting the loads 

Loads are entities that can be adapted 

1. Select the load(s) to be adapted  

2. You can use the ingenious properties table, allowing for a fast adaptation of the properties. 

3. For the outer trusses, a snow load of –2.25 kN/m must be taken into account. 

 

Adapting a series of concentrated loads 

The centre beams are bearing twice as much load as the outer beams.   

1. Select the two series of concentrated loads of the centre frame.  The properties table shows the 
settings of this item.  

2. In the properties table, change the value of the force into –20kN.  
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The first load case now being complete, we will complete the second load case.  Activate the second 
load case.  

Click in the field of the list box and choose LC2. 

 

Now, load case LC2 is active. 

 

The second load case contains a simplified representation of the left-hand side wind load 

The columns of the first and the last frame are loaded with 1.5kN/m 

The columns of the centre frame are loaded with 3 kN/m 

At the roof trusses of the outer frames, the suction force amounts up to 2.5 kN/m 

The roof truss of the centre frame is submitted to a suction force of 5kN/m 

Below, you see the image of the load to be defined. 
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Figure 25: The simplified load case wind 1 

 

Entering a distributed load.  

1. We start from a situation, in which nothing is selected.  Use the  icon to cancel any previous 
selection.  

2. Double-click . The Line load on member dialogue is opened. 

3. Set property Direction to X 
Set property Type to Force 
Set property Value to 1.5 
 

  
Figure 26: Menu of an equally distributed load 
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4. Confirm with [OK]. 

5. Select the four columns of the outer frames.  

6. Click the right mouse button to confirm your input.  

7. The elements of a new input are selected. Press the <Esc> key to cancel the selection.  

 

Copying loads 

Load cases are entities, which can be copied.  In this project, we do not need this action.  If you want to 
copy loads, follow the procedure below. 

1. Select the load to be copied. 

2. Use the button Copy additional data  

 

3. The command line asks you to which members you want to copy the selected load. 
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Combinations 
When all load cases are defined, we can define the combinations. 

 

Defining combinations:  

1. Choose in the service Menu  >  to enter linear 
combinations of the defined load cases. 

Since there are no combinations, a new combination is created immediately after opening the 
Combination manager.  

 

Figure 27: Combination - CO1  

2. By default, a Self - UGT combination is created; this implies that the program will automatically 
make all possible combinations with these load cases.  It will take the type (Proper weight, 
Permanent, Variable) into account and multiply the different load cases with the entered factors . 

3. Change the Type in EC – UGT Complex 

Now, the combinations are automatically generated to EC. 

4. Click  [Add all] below the list of load cases to add all load cases to the combination and click 
[OK]. 

You will return to the Combination manager. 

5. Apart from this combination, we also add the combination EC-BGT for the serviceability check 

(deformations).  Click [New] or   , change the Type in EC-GGT-Complex seldom and click 
[OK]. 

6. Click [Close] to close the combination manager. 
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Load rules 

You can always consult the content of the combinations on beforehand.  

 

1. Set the list to Combination content 
 

 

2. Now, the combinations menu contains the different load rules, with which the real 
combinations will be generated. 
 
For UGT.2, which is selected in the figure below, two combinations will finally be generated: 
 
1.35 LC1 
1.35 LC1 + 1.5 LC2 
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Calculation 
Linear calculation 

The calculation now being complete, we can launch the calculation.   

 

Carrying out the linear calculation 

1. Double-click  > . 

  The dialogue EE-solver, net generation settings appears. 

2. Click [OK] to start the calculation.  After the calculation, a message appears on the screen that the 
calculation has been carried out.  Close this window with [Close]. 
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Results 
Viewing results 

When the calculation is OK, choose in the Main service to view the results of the 
calculation. 

 

Viewing the result of forces on members, graphically represented on the structure 

1. To view the results of forces on members, double-click  in the Main service.  The 
Results service becomes active. 

By default, the Internal forces (My) are shown on all members. 

2. Select the members of one of the centre trusses. 

The members are highlighted in rose. 

3. In the properties dialogue, configure the properties as follows: 
Set the Selection property to Default, so that you can select yourself the elements for which you 
want the results  
Set the Load type property to Class to view different combinations  
Set the Class property to All UGT-combinations to view all UGT combinations  
Set the Extreme property to Beam to obtain extremes per beam  
 

   

4. Click  behind the Reread property 

 

The beam extremes are shown for the selected members.  

 44



SCIA.ESA PT 

 

Figure 28: Internal forces on member 

 

Viewing the result of forces on members in tabular form 

This time, we will search the global extremes of the entire structure 

Set the properties as follows: 

1. Set the Selection property to All 
Set Extreme to Global 
 

 
 

2. Use the Print Preview service, by clicking the . button to obtain a numerical output of 
the internal forces on the screen.  A new frame will appear between the graphical part and the 
command line. 
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5. To see a larger part of the results, enlarge this frame.  
 

 

6. Click the cross in the upper left corner of this frame to close it. 
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Document 
Documentation 

When the calculation is finished, we can generate a calculation note.   

 

Creating documentation 

1. Choose  Document in the toolbar.  

The screen will change and the Document service will be opened.  The Document service will 
show the content of the document. 

2. Click with the right mouse button in the white part of the Document service. 

The dialogue New document part appears. 

 

Figure 29: New document part 

3. Choose Project and click [Add]. 

4. Open the Libraries group and select Section. Add it. 

5. Open the Construction group and select Members. Add twice. 

6. Open the Results group and select Internal forces on member. Add. 

7. Close the dialogue. Click [Close]. 

 

All chapters will appear in the service to the left side of the screen.  You can move an element by 
dragging it with the mouse.  At the right side of the screen, a print preview of the document is shown.  
You can browse the document by clicking the elements in the menu to the left or using the scroll bar at 
the right-hand side of the screen. 
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Modifying the table of contents 

1. Move the chapter Members and drag it towards the Sections chapter. 

The Members item becomes a paragraph in the Sections chapter. For each section, the members 
are shown with that section. 

 

 

2. Move the chapter Internal forces on member and drag it towards the second added chapter 
Members. The internal forces are shown for each member. 

 

Modifying the properties of a table  

1. Select the paragraph Internal forces on member. 

The properties are shown. 

2. Choose for the Load Type property the value Class and for the Extreme property Beam. 

For each member, the results of that member are shown for the class all ULS combinations and 
only the extremes of the beam are shown. 

 

Adding an image to the document  

1. At any time, you can click  in the toolbar and choose Image to document to send the content of 
the graphical window to the document. The following dialogue will appear. 
 

 

Figure 30: Add image to document 

2. In the Name field, you can enter the text for the image. The size of the image (Size (% of page)) 
can be chosen as a fraction of a full page (50% is half a page). The image can be fit to the window, 
fit to the range or you can zoom everything (Zoom all). Furthermore, you can rotate the image 
('landscape'). 

3. If you click [OK], the image is inserted in the document. 
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Cad form 
Cad form 

 

By means of the Cad form options, you can generate true drawings of the structure.  This means that, 
apart from the computational model, the program can contain the drawing model as well. 

The options to generate a Cad form are only available when you have selected the Cad form option on 
the Functionality tab of the project data. 

 

Parameters to set a Cad form  

 

The main parameters to configure the drawing model are: 

• The priority of a member:  
 
The priority of a member is set in the member properties.  This is a value, which is 
proportional to the importance of the profile.  In this way, you determine the members that 
should be drawn continuously in the graphic representation.  A member with a smaller priority 
is cut off of a member with a higher priority value. 
 
A series of default priorities are implemented, but you can set the priority yourself as well 

• Geometric parameters: 
 
For the properties of a member, you will find in the Cad model group a number of parameters 
allowing for a correct alignment of the element on the structure. These parameters are 
independent of the default parameters for rotation and eccentricity. 

 

Setting a default priority type  

1. Select the columns 

2. Set the Type property to Column(100) 

The beams of the different frames are set to beam (80).  The roof bracings are set to Horizontal 
bracing (0) 

 

Setting a priority value  

1. Select the beams connecting the different frames. 

2. In the properties table, in the Cad model group, set the Priority definition property to manual. 

3. Set the value of the property Priority value to 75. 
 

 

 

Generating the Cad model 
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After having set all parameters, you can generate the Cad model using the option Generate Cad form 

(button  ) in the toolbar.  In the figure below, you can see an image of the Cad form. 

 

 

 

Figure 31: Image of the CAD model 
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Code check 
Steel code check 

The steel code check is implemented for different codes. In this Tutorial, we will only discuss EC.   

For a stress analysis of the steel, the program must dispose of results.  The options for the steel code 
check can be found in the Main service under . 

The following checks are provided: 

•   This option includes a stress analysis and a stability check.  

• : This option includes a slenderness check 

• : This option includes a check of the relative deformations 

The program is able to apply local reinforcements.  The following possibilities are implemented.  

•  

•  

•  

•  

•  

Before you can start a check, the element must be properly configured.  The strut type and the system 
length are highly important.   

• The default configuration of strut type is implemented and can be set through the option 

. 

• The program calculates the system lengths.  These system lengths can be represented through 
the image parameters (image parameters > entities > buckling lengths) 

The program contains the library objects ‘buckling’, enabling you to overwrite the default settings for 
strut type, system length and deformation length.  
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Representing the system lengths on the structure  

1. Start with a situation, in which no object is selected.  Click to this end in the toolbar on the 

option Cancel selection (button ).  If nothing was selected, the button will not be active. 

2. Click with right mouse button in the graphic part.  The menu Image parameter setting will be 
opened. 

3. Choose the Entities tab. 

4. In the group Construction, choose the option Buckling lengths 

The system lengths are represented on the structure.  In the image below, the representation of the 
section was activated as well. 

 

Figure 32: structure with system lengths 

Notes: 

The system lengths are only represented on elements, which are connected with other members in 
their field. For elements consisting of one single part, such as the horizontal beams of the frames in 
our structure, no system lengths will be represented. 

The system lengths are automatically cut off in the hinges. 
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Default configuration  

The default configuration for all members can be set in  

• The default strut type is set in the tab: Setting for steel member check. 
 
If you take YY non-strutted, by activating the radio button, this implies that the strong axis of 
the profile will be non-strutted. 

• The default system lengths and deformation lengths are set in the tab buckling settings. 

• The requirements for the relative deformation check are set in the tab setting of the relative 
deformations. 

  

Configuration of the columns  

Below, you will find an image of the structure. The following image parameters are activated: member 
names, member LCS, section and system lengths. 

 

The figure shows the default configuration. 

The program finds for the system lengths of Ly (for the strong axis) a length of 4m and for Lz (the weak 
axis) a length of 8m. 

The default strut type is strutted for the strong axis and non-strutted for the weak axis.  This does not 
comply with our structure.  In this model, the columns of the strong and the weak axis are non-strutted.  
This can be set using adapted buckling parameters. 
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Setting the buckling parameters for an element  

The program contains a library with buckling configurations.  A number of buckling parameters can be 
set.  Next, the setting can be linked to different members.   

1. Select a column with the mouse cursor 

2. The Buckling lengths property of this member indicates the value default.  This means that the 
default configuration is linked to this element. 

3. Click the  button behind default to create a new series of buckling parameters.  Since the 
library does not contain any objects yet, the Buckling data menu is opened.  
A new series of buckling parameters is created.  By default, the program had found that this 
object consists of two parts, whereof the Y-axis is connected at half-height.  The new object is 
a copy of the default configuration and is called BC1. Below, an image of the library 
containing BC1. 
 

 

Figure 33: Buckling data 

4. Click the  button to set the properties for this object.  The menu Buckling lengths will be 
opened. 
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5. The tab General settings must be interpreted as follows: 

 
The field next to Name contains the name of the object. Enter a recognisable name. 
 
The value yy represents the system length of Ly and does not figure in the menu, since the 
system length for Ly is always calculated by the program. 
The value zz represents the system length for the weak axis.  We can take it equal to Ly. This 
means that the value of the zz fields must be set to yy. In our model, we want the program to 
calculate the system length for Lz as well.  Enter value zz for the property zz. 
The other system lengths, Lyz and It, are taken equal to Lz. 
The relative deformation in Y-direction has the system length of Lz as basis.  Therefore, set the 
value of verv.yy to zz. The same applies to verv.zz 

6. The tab buckling data is set as shown below: 

 
The column has a length of 8 m. The strong axis has a connection at 4m.  This one is fixed at 
the start (1) on the location of the connection in the field (2) and at the end(3). 
The member parts between (1) and (2) and between (2) and (3) are non-strutted.  Therefore, we 
set the property Non-strutted to YES. (Same consideration for the weak axis.) 

7. Confirm your input with the [OK] button. 

8. Select the six columns and set the Buckling lengths property to BC00*0 
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Also configure the other elements 

 

First, we will carry out a global check.  We want the result to be represented in graphic form, drawn 
directly on the members of the structure. In this way, we can easily localise possible problems. 

 

Configuring the graphic output  

Before carrying out a check, we will configure the graphic output.  This will be done just once. 

1. Select with the mouse the option  in the Steel service. 

2. The properties table shows the properties of a check.  Click the  button next to Set graphic 
image. The following menu appears on the screen. 

 

3. The result of a check is shown as a unity check.  The program allows the configuration of two 
limit values, an upper limit and a lower limit.  
Sections of members that do not comply with this code have a unity check higher than 1.  This 
will be our upper limit.  Members whereof the unity check is inferior to 0.25 are badly used.  
This is our lower limit.  
The upper and lower limit unanimously delimits 3 zones.  We can associate a colour to each 
one of these zones. 
A unity check of less than 0.25 means that the member is poorly used.  We choose a blue 
colour.  A unity check between 0.25 and 1 shows that the result is optimal.  We take a green 
colour.  For a unity check of more than 1, the member is not code-compliant.  We choose a red 
colour. 
 
Now configure the values and colours in the menu Set graphic image.  
 
The graphic result of a check on sections of members will now always be represented in one of 
the chosen colours. 
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Graphically representing the result of a check  

The check must be carried out for all members all UGT combinations. 

1. Set the properties of the check. 
Set Selection to All: we want to check all members  
Set Load type to Class: we want to consider a set of actions 
Set Class to All UGT- combinations: we want all UGT combinations 
 
Below, you will see the settings. 

 

2. Click  behind the property Reread. 

 

 

The result shows that there is a problem with the floor beam of the first floor.  We also remark that 
the roof bracings do not satisfy. 

 

 57



SCIA.ESA PT 

 

We analyse the problem of the floor beam by means of a section check. 

 

 

 

Section check 

 

For a section check, you only need to set the combinations or load cases for which the check must be 
carried out.  

1 In the properties table, set the Load type property to Class and the Class property to All UGT- 
combinations. 

 
Figure 34: Properties steel check 

2 Click  behind Section check.  The command line will ask you for which entities the check 
must be carried out. 

3 Select the floor beam of the second truss. The following menu will be opened 
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4 In the Image group you can choose between:  
Check if you want to obtain a concise report of the checked member  
NVM to view the section forces of the representative combination. 
Profile if you want to see a detailed report of the stress check. 
Stability if you want a detailed report of the stability check of the element. 

 

The report shows that the stability check does not comply.  The member buckles. 

 

Adding buckling supports 

In reality, the upper flanges of the floor beams are fixed through floor slabs, which constitute a stability 
against buckling.  In the model, we will add buckling support to the upper flange of the beam. 

1. Select  

2. We will define three buckling supports.  The first at 1 meter from the start of the beam.  The 
intermediate distance of the supports is 3m. The configuration is represented in the image below. 
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3. Select all floor beams of the first floor. 

4. A new section check shows that the element now complies. 

 

Through an optimisation, we can found out if it is possible to lower the profile types.   

 

Carrying out an optimisation 

1. First, we have to set the properties to carry out an optimisation.  
 
Set Filter to Section 
Set Section to IPE400 (section type floor beam) 

 

 

2. Click  behind optimisation.  The menu section optimisation appears. 
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3. Click the button Optimisation to start an optimisation.  The program will search the lowest IPE 
profile that still complies with the check.  The new profile type is immediately assigned to the 
beam.  
 

 
 
The program thinks that an IPE360 is an appropriate choice.  Leave this menu by clicking [OK]  

 

 

4. Since the profile has been changed, the construction needs to be recalculated, before we can 

continue.  Start the recalculation using the Hidden calculation button  in the toolbar. Now, the 
program can continue  
 
You can further optimise starting from the new forces distribution.  

 

We want a print preview with a short report of each member 

 

Print preview of a code check 

 

1. In the properties table, set the parameters as follows: 
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Set Selection to All 
Set Filter to No 
Set Output to Short 

Open the report by clicking  behind Print Preview. 
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Fire resistance check 
 

The program includes a module to carry out a fire resistance check for steel structures. 

The tools to configure and check the fire resistance are gathered under the option  in the 
Main service.   

The options are only available if you have selected the option Fire resistance on the Functionality tab 
of the project data. 

 

 

The basic configuration for fire resistance can be found under  in . 

The definition of fire resistance is an additional data of a member (just as load, hinge…).  When 
carrying out the check, only those members, for whom the fire resistance was defined, will be 
considered. 

The fire resistance check must be carried out with UGT - incidental combinations.  These combinations 
only make sense in case of an incidental load.  In this example, we will NOT create a third load case.  If 
we would create a third load case, we would be unable calculating the project in demo mode.  We will 
discuss the procedure, although with an ordinary UGT combination 

 

Defining the fire resistance 

1. Double-click the option  in the Main service. 
The fire resistance menu appears on the screen. 
 
 

2. Set the parameters in the Fire resistance menu. 
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In our example, we will install Plate material of 10mm 
We will check an 1800-s fire resistance. 
 

 
 
If you set the buckling ratios ky and kz to zero, the buckling ratios defined for steel will be 
used.  If you redefine ky and kz in this menu, the default buckling ratios will be overwritten. 

3. When the parameters are configured, confirm with OK. 

4. Select the members that must feature the defined fire resistance. 
 

 
 
On the selected members, the label is represented. 

 

 

Checking the fire resistance  
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1. Double-click the  option in the Steel service to activate the 
function. 

2. Set up the Properties table for the result configuration. 
 

 
 
We will choose a general check with one extreme per beam, for UGT combinations.  

3. Start the check by clicking the  button behind Reread 
 
In this way, the result will be displayed in a graphic manner. 
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Connections Module 
Connections 

The Connections module of SCIA.ESA PT has been developed to design frame connections from steel 
constructions. 

The options to define and calculate the connections are normally not activated.  If you want to activate 
the connections modules, you must select them in the project data menu on the functionality tab.  When 
selecting a functionality for a type of connection, the CAD form option is automatically selected as 
well. 
 

The CAD form option serves to generate a drawing model of the structure.  For more details, please 
refer to the Cad form chapter. 

 

A connection is designed with the results of UGT combinations. If the results are no longer available, 
you must start a calculation. 

 

The priority assigned to the members to be connected is highly important.  For instance, if you want to 
design a beam-to-column connection, the column should have a higher priority than the beam.  For a 
beam-to-beam connection, the beams must have an identical priority.  For more information regarding 
the priority, please refer to the Cad form chapter. 

 

We will design a bolted connection strong axis-to-strong axis in node K4.  

 

Copying bolts from the system database  

The program integrates a bolt library, containing a set of predefined bolts.  You can define additional 
bolts as well. 

It is useful to previously select a number of bolts, thus facilitating the design when you want to 
configure bolts. 

1. In the main menu, choose the Bolts library under the option . The Bolt 
positioning menu is opened. 

 

Note 

In the SCIA.ESA PT object libraries, you can  

Create new objects using the  button 

Load objects from the pre-programmed database using the  button. 

Open objects from your own database using the  button 
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Save objects in your own database using the  button. 

 

2. Open the system database by clicking the  button. 

3. Search the M20-4.6 bolt in the system database and select the line with the mouse cursor. 

4. Click the [<<Copy to project] button to copy bolt M20-4.6 in the project database. 

5. Position bolt M20-8.8 in the project database using the same procedure. 

6. Quit this menu with the [OK] button. 

7. In the Bolt positioning menu, remove all other bolts, by selecting them and then clicking on 

the  button. Below, you will see an image of the user library, which only contains the two 
desired bolts. 

 

Figure 35: Menu Bolt positioning 

8. Quit the Bolt positioning menu with the [OK] button. 

Note: 
The last element that is added to the library will be active by default. If an application uses a library object, the 
active object is taken.  You can activate any other object from the library by double-clicking its label. 

 

Defining a connection 

1. Start the function Frame bolted/welded ( ) using the 
menu function Menu tree > Steel > connections > frame bolted / welded. 
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2. Select the node where the connection must be designed.  In our example, we will take node 
K4. 

3. The program automatically selects all members arriving in the selected node.  If necessary, 
you must deselect the members that are not part of the connection to be designed.  In our 
example, we will deselect the bracing and the buffer beam realising the connection with the 
next frame.  The figure below shows an image of the selection. 
 

 
 

4. Use the right mouse button or press Esc to confirm the selection.  
The program automatically creates the connection in the selected node.  In the properties 
table, you will find a new part that is highlighted in green.  These are new options to 
configure the current connection.  (The properties screen only shows those parameters, which 
are relevant to the selected connection type).  
Hereafter, we will set the parameters to obtain a correct connection. 
 
Below an image of the properties table. 
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The type of members to be connected is highly important.  The possible connections proposed by the 
program directly depend on the type configured.  
In our example, we are designing a beam-to-column connection.  The element that must be calculated 
as column should have a higher priority than the beam.  The members of the connection in our example 
are configured as follows: 
The column is of the default type Column(100). 
The beam is of the default type Beam (80). 
 
For more information regarding the configuration of priority types, refer to the Cad form paragraph. 

 

5. Activate a cap plate by checking the check box behind Cap plate.  

 

Each time you add a component to the connection, it will be shown in the graphic part.  If you zoom the 
connection, you will see the components in the detail. 

6. Activate bolts by checking the check box behind Bolts. The currently active bolt in the bolts 
library will be used for the connection.  If you did not change the active bolt, the current 
connection will contain M20-8.8 bolts.  

7. First, we want to try M20-4.6 bolts. Click the button  behind Bolts.  
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8. In the Properties menu, set Selected bolt to M20-4.6 
 

 

9. Click [OK] to leave the Properties menu. 

10. Click the button  behind Reread to update the data. 

11. Click  to open the check menu.  Below, you will see the report menu of the check. 
 

 
 
The connection is not OK.  The moments' capacity is too small.  The line of the unity check is 
highlighted in red. 
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Before starting the check of a connection, first click the  button behind Reread. In this way, you 
are sure that the check is carried out using the current data. 
If the connection is not code-compliant, the non-compliant element is highlighted in red in the result 
screen.  
The result menu always indicates the weakest link of the connection.  

12. The check menu indicates that the bolts under tensile stress are the weakest part. 

13. We will use stronger bolts. Click  behind Bolts.  Now choose M20-8.8 bolts. 

14. Carry out another check.  Click  behind Reread to update the data.  Click  to 
open the check menu.  The connection is OK.   

15. We want to increase the stiffness of the designed connection by installing a stiffener at the 
column head.  You can activate this stiffener by checking the check box behind Cap plate. 

Each time when you activate a new element of the connection, it will be represented in the 
graphic environment.  Below, you will see an image of the current connection. 

 

 

Figure 36: The designed connection 

 

Print preview with the report of the check of the connection  

1. Select the connection(s) by clicking on the label(s).  

2. You can choose the extensiveness of the report in the properties table.  By default, the Output 
property is set to Normal. (You can choose between concise, normal and detailed). 

3. Click  behind Open print preview. You will obtain a print preview of the calculation. 
 

Isolating the connection using the cut box  

1. Activate the connection by clicking on its label.  If the connection is already selected, skip this 
step. 

2. In the main menu, choose the option Around selected entity in Image > Cut box.  

For more options of the cut box, refer to the Cut box paragraph. 
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Generating the Cad form from a connection  

1. Set up a cut box to isolate the current connection.  If you already have set up a cut box, 
skip this step. 

2. Set the image parameters for a rendered structure. 
With the  button, a volume model will be represented. 
With the  button, the volume model becomes opaque 

3. Use the option “Generate Cad form”  (button  in the toolbar) to activate the Cad 
form.  

 

 72



SCIA.ESA PT 

Grid lines 
The grid lines are useful tools that can be used for the geometry input.  They enable you defining a two- 
or three-dimensional grid, whereunto you can directly draw the structure. 

Upon the input of the structure of this example, we did not use grid lines. In this paragraph, we will 
define the grid line, on which you could have drawn the model of this Tutorial. 

 

Creating the grid 

1. Choose  Line grids in the toolbar.  

The screen will change and the line grid dialogue will appear. 

2. Enter for the X, Y and Z-direction the different distances with their repetition factor.  For Span, 
enter the distance, for Repetition, the number of times that this distance must be repeated.  We 
want to enter a line grid of (8m x 1; 7m x 2; 4m x 2). To obtain this, enter the parameters as shown 
in the figure below. 
 

 

Figure 37: The line grid 

 

3. Confirm your input with [OK].  

4. The Line grid manager is opened.  You can modify the input coordinates and the property 
Visible. Take the insertion point at coordinate (0;0;0) and the property visible activated. 
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Showing / hiding the line grid  

1. Click  to open the line grid library. 

2. Check the check box of the property Visible to show the grid (make it visible).  (Uncheck the 
check box to hide the line grid, i.e. make it invisible.) 
 

 

 

Setting up the snap mode to snap on a line grid  
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In order to enable snapping with the mouse cursor on the line grid, this option must be set. 

1. Click the [Pick mode] button at the bottom of the screen. The Cursor pick setting is opened. 

2. Activate the check box of the Line grid property. 

3. Confirm the settings with [OK]. 
 

 

Figure 38: The Cursor pick settings menu  
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Image gallery 
The image gallery is a tool to create, edit and save drawings. 

The image gallery includes a wizard enabling a smooth generation of layouts.  To this end, the 
advanced project level must be activated in the project data and the option Layouts must be selected in 
the Functionality tab. 

The image gallery contains a second wizard, enabling a smooth generation of mono-drawings of 
connections.  To this end, the option Connection mono-drawings must be selected in the project data. 

 

Sending a drawing to the gallery 

 

1. Configure the graphic part of the model.  We take a rendered image of the structure. 

2. Click the  button at the bottom of the screen to send the drawing to the gallery. 

3. The Image name menu is opened.  
 

   

 

Editing a drawing of the gallery.  

1. Click the  button to open the gallery.   

2. Select the drawing to be edited by pointing it with the mouse. 
 

 

3. Activate the drawing in the gallery using the  button 
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The gallery contains options to 

• Draw lines, arcs, ornaments... 

• Position texts 

• Position dimensioning 

 

Using the Layout Wizard  

The Layout Wizard is based upon the line grid.  For all planes of the line grid, drawings of the structure 
including dimensioning are created. 

1. Double-click  in the tree menu. The image gallery service is opened.  

2. We want to create the layouts using the wizard. Double-click Cuts per planes according to line 

grid (layouts) (button ). 

3. The first screen of the wizard appears, in which you can set the drawing options.  
 

 

4. Click . The second screen appears.  This screen contains options to change the screen 
settings. 

 77



SCIA.ESA PT 

5. Click . The third and final screen is opened.  Here, you have to choose the cuts to be 
created.  By default, all cuts are chosen.  

6. Click .  The layouts are created. 

 

 

 

The Connection Mono-drawings Wizard  

The Wizard for Mono-drawings of connections works in a similar way. 
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Paperspace gallery 
 

In the paperspace gallery, you compose the definitive drawings from previously created entireties.  The 
composed drawings are saved here together with the project.  You can print a drawing at any given 
moment. 

 

1. Double-click in the tree menu  

2. Create an empty drawing note in the gallery using the  button 

3. Click  and choose Import image from gallery. 

4. Select a drawing from the image gallery.  Click on the name of the desired drawing: the line is 
highlighted in blue.  
 

. 

5. Then, click [Close]. 

6. You will return to the drawing note of the paperspace gallery.  Drag the mouse to move the 
drawing to the desired position.  Then click with the left mouse button to fix the drawing. 
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Finally, a composition can look like the image below. 

 

 

 

 

 80



SCIA.ESA PT 

Cut box and Activities 
Cut box 

Cut box is a powerful tool facilitating adaptations, especially for excessive and complex constructions. 
The Cut box defines a range or area (3D-area) that is visible on the screen.  The remainder of the 
construction, located behind this area, is temporarily hidden for the user. 

 

Defining the cut box 

1. Click the button Set Cut box for active image  in the Image toolbar and select the Cut box – 
new function. 

2. Define the origin (i.e. the centre of the Cut box.) 

3. The settings dialogue appears on the screen. 

4. Complete the table. You can set the origin, the size and the angle. 

5. Confirm with OK 

 

Adapting the cut box with the mouse  

1. Turn the Cut box ON (click the button Set Cut box for active image  in the Image toolbar and 
select the function Cut box (on/off). 

2. Position the mouse cursor above one of the borders of the Cut box. 

3. Click the left mouse button to select the Cut box 

4. In the middle of all Cut box surfaces, special edit symbols are shown for the box.  The ball symbol 
provides for the modification of the box size, the cylinder symbol enables the user rotating the box. 

5. Select the symbol corresponding to the desired adaptation 

6. Click the left mouse button and keep it down 

7. Drag the mouse to adapt the Cut box according to your wishes 

8. Release the mouse button. 

9. Press the Esc key to close the adaptation function.  

 

Other possibilities for the cut box set-up can be found in the reference manual. 
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Activities 
The activity property provides for a selection of only those members, which are indispensable for a 
certain adaptation or action.  The remainder of the construction is temporarily hidden for the user.  

 

Activity types  

The user can define the active construction part in different ways. 

(i) Layers  The activity is entirely controlled by layers 

(ii) Work plane Only members located in the current plane become active. 

(iii) Selection Only currently selected members become active. 

(iv) Cut box Only members located within the current Cut box become active 

 

 

Activate or deactivate Activity  

(i) Open the function Tools > Activity > Activity on 

(ii) Or click the button Activity on (or Activity off) in the Activity toolbar ( ) 

 

 

Activity through the work plane 

(i) Open the function Tools > Activity > Activity through work plane 

(ii) Or click the button Activity through work plane in the Activity toolbar ( ) 

 

 

Activity through Cut box 

If this type of activity is selected, all members located within the currently adapted Cut box will become 
active. All other members become inactive 

(i) Activate the Cut box and adapt it in the desired way 

(ii) Or open the function Tools > Activity > Activity through Cut box or click the button 

Activity through Cut box in the Activity toolbar ( ) 
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